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Features of DS-Win V4
1 DS-Win V4

DS-Win V4 is an electronic phone book designed for attendant consoles and office worksta-
tions. It consists of DS View for the application as well as GUI Designer and DS-Admin for 
customization and modifications. It has been designed on the basis of the latest technical 
know-how and is extremely user-friendly. The wide range of features offered by GUI Designer 
and DS Admin enable you to configure your phone directory to suit your special requirements 
and thus optimize it for your work. 

1.1 Features of DS-Win V4 

Application Areas

The DS-Win V4 electronic phone book can be integrated fully in the PC attendant console AC-
Win IP V2 and BLF-Win V4. Used in conjunction with this product, it provides a complete sys-
tem that leaves nothing to be desired in terms of functionality, flexibility and user convenience. 
No matter whether you are looking for the phone number of a subscriber, a particular key word, 
a specialist field or a sphere of responsibility, all you have to do is press a few keys and DS 
View does the rest.
DS-Win V4 can, however, also be used on an office workstation. The integrated dialing aid al-
lows a call to be set up automatically from the connected telephone after the desired call part-
ner has been found.

DS-Win Characteristics

The DS-Win V4 electronic phone book is a directory service that can be customized for use on 
a PC and in a client/server configuration. The following functions are available:

● Telephone information system for attendant console and/or workstation with DS View func-
tions

● Configuration of the database and the user interface to one’s own requirements with DS-
Win Designer

● Administration of all subscriber data including display of notes

● Distributed database, client/server technology

● Synchronization with host databases via LAN 

DS-Win V4 is a 32 bit program that runs on Windows Vista® Enterprise (32  bit), 
Windows Vista® Business (32  bit), Windows 7 Enterprise (32 bit) and Windows 7 Ultimate (32  
bit) operating systems.
A31003-G6640-U100-2-7619, 03/2010
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Features of DS-Win V4
Individually Configurable Database

The new DS-Win V4 database provides you with tables in which you can record data such as 
employee names, room numbers, departments, eMail addresses, product catalogues, keyword 
lists and much else. Apart from permanently set tables in which you can adapt the fields to suit 
your requirements you also have the option of adding new fields and even of creating new ta-
bles. This is particularly useful if you want to have access to information that has only an indi-
rect bearing on the telephone directory, such as hotel or restaurant addresses, notes, proce-
dures, and so on.

A corresponding JDBC driver also provides access to other databases such as MS SQL Server 
2005, MS Access and MYSQL. Existing databases containing your personal data, for example, 
can thus be used. 

Individually Configurable User Interface

You yourself can determine how your data will be displayed on the screen. For this purpose, 
DS-Win V4 includes a design tool (see the DS-Win V4 Designer manual) that provides you with 
all the resources you need to configure the output of information on the screen in line with the 
requirements of your work. 

Finding and Modifying Data 

There are two basic search modes available: speed search and query. 

● For a speed search, enter individual characters in a search field and move progressively 
closer to the subscriber or term you are looking for until the "correct" one is finally found. 

● In query mode, enter several search criteria, where necessary, and let the system search 
for all data records that correspond to these criteria.

You can move (navigate) in the dataset, rearrange the search result according to different cri-
teria, edit or delete records or add new ones.

Dial Functions

DS-Win supports not only the automatic telephone dialing equipment of the PC attendant con-
sole AC-Win, but also the optiPoint telephones through the USB interface. It can thus be used 
at both an attendant console as well as an ordinary workstation. 

Printing Data

You can select different layouts for printing your data records or search results with the option 
of printing the entire dataset or individual records. DS-Win iReport from JasperSoftuses the 
software which can be used to create test pages.
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Configuration Overview
Import/Export

Large volumes of data can be imported and exported via a flexible interface. The DS-Win da-
tabase can be synchronized with host databases, for example the central HDMS/HiPath 4000 
Manager (HP4KM) database, either manually or automatically according to a predefined time-
table.

1.2 Configuration Overview

Figure 1-1 Configuration Overview: DS-Win - HiPath 4000 Network
A31003-G6640-U100-2-7619, 03/2010
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Concept of the DS View User Manual
1.3 Concept of the DS View User Manual

Purpose of this Manual

This manual describes how to operate the system from the perspective of the user. The manual 
should 

● describe the correct procedure for using DS-Win functions,

● indicate the correlation between the individual functions,

● serve as a reference for users familiar with the product.

An index and glossary are included.

Structure of the Manual

The application-based chapters of the DS View User Manual are: 

● Chapter 2: 
Using the Data View Window, which provides access to the available data.

● Chapter 3:
Using an eMail Client and Presence Management. 
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Starting DS-Win
2 Data View

DS-Win is operated via the "Data view" window. This provides the user with an interface for 
entering and displaying phone book data. 

2.1 Starting DS-Win

If the entries are correct, the "Data View" window is opened.

> Important
In the following description of operating procedures it is assumed that the system is 
fully installed and ready for operation.

Step Action

1 Via "DS View" in the Start menu, open the application under Programs DS-Win 
V4. A connection to the license server as well as a valid license are prerequi-
sites for this. 
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Settings
2.2 Settings

2.2.1 Application Settings

The first time you start DS-Win, you will need to make the following settings on the Dial pa-
rameters tab in the Options/Application settings menu in order to operate DS View. 
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Settings
● Standard dialog form
Select the dialog document for DS View. This form will be invoked the next time you start 
DS View. 

● Default language
Specifies the default language to be used the next time DS View starts.

The following settings under "Dial parameters" are for configuring automatic dialing.

● Modem
This setting is only required if you are using DS-Win without AC-Win. Select the connection 
type from the drop-down list. The options are:

– HDAUDIO SoftV92 Data Fax Modem

– RAS PPoE Line 0000

– RAS-VPN-Line 0

– WAN-Miniport (L2TP)

● Country code (required input)
Enter your own country code here.

● Area code (required input)
Enter your area code here.

● Net code (required input)
Enter your net code here. For further information, consult your specialist staff.

● Tie number (required input)
Enter your system’s tie number here. For further information, consult your specialist staff.
If your configuration uses tie numbers, it is very important that you enter them, since 
DS View can only process tie numbers if they are entered here.

● Trunk access (required input)
If trunk access is used in your system, enter the code here. For further information, consult 
your specialist staff.

● National access code (required input)
Enter an access code here for calls to the national network, e.g. 0.

● International access code (required input)
Enter an access code here for calls to the international network, e.g. 00.

● Domain list
Enter one or more domains.
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Settings
2.2.2 Presence Settings

Choose the Presence Management tab under Application settings to access the application 
settings.

● Use Presence Management
This checkbox is not ticked. If you want to use presence management, tick this box. You 
need MS Outlook for this option. DS-Win has to be restarted for the on/off setting to take 
effect.

● Mail Client
This setting depends on whether you use MS Outlook or Lotus Notes. Both cannot be used 
at the same time. 
 A31003-G6640-U100-2-7619, 03/2010
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The Domino Server settings are only valid when Lotus Notes is used. If you use MS Outlook, 
these fields are inactive.

● User ID <full name>/<organization>
Indicates the name of the Lotus Domino administrator under which DS View can access 
and obtain presence data.

● Password
The password required for access to the ID file. When you enter your ID and password in 
this dialog, these values are stored in the DSWin_View_config.xml file. This is necessary 
for automatic login to Presence Management in Lotus.

● Domino IIOP Server <IP Number>:<Port>
The default port is 63148.

● Number of maximum work days
The search for appointments is limited by the value specified for the maximum number of 
work days. 
The following applies for Outlook: Work days are considered to be all days except Saturday 
and Sunday. Holidays are ignored.

● Start work hour
The time when the work day starts. This value specifies the beginning of the daily interval 
in which appointments can be searched for.

● End work hour
The time when the work day ends. This value specifies the end of the daily interval in which 
appointments can be searched for.

● Refresh period (Min)
Update period for Outlook – The default is 3 minutes

● Time zone
You will find further information in the Outlook documentation.

● Request inactivity threshold (mSec)
This value is given in milliseconds. It specifies the amount of time until a new retrieval of 
appointment data when you change entries in the DS View data view. 
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Settings
2.2.3 AC-Win Settings

Choose the AC-Win tab under Application settings to access the AC-Win settings.

● Record selection originators

– Attendant intercept
Caller – Destination
This parameter regulates which record is selected following a normal attendant inter-
cept: caller or destination

– Attendant recall
Caller – Destination
This parameter regulates which record is selected for a recall.
 A31003-G6640-U100-2-7619, 03/2010
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● AC-Win Server

– IP number
This parameter is stored in the DSWin_View_config.xml configuration file.

– Port number
The default setting for the port is 54700. This parameter is stored in the configuration 
file DSWin_View_config.xml.

– Part of AC-Win window title
The ACWin title is stored in the DSWin_View_config.xml configuration file. The first 
characters show suffice (case sensitive)

● Search parameters

– Grid name at int. call:
Grid1 should be set here for reasons of backward compatibility. The ACWin query is 
performed in the first table.

– Grid name at ext. call
Grid1 should be set here for reasons of backward compatibility. The ACWin query is 
performed in the first table.

– Search field at int. call
Database field name in the subscriber table (controls the choice of data record in the 
event of a query from ACWin. TieInvertedNumber should remain set here for reasons 
of backward compatibility.

– Search field at ext. call
Database field name in the subscriber table (controls the choice of data record in the 
event of a query by ACWin. InvertedNumber should remain set here for reasons of 
backward compatibility.

– Tabsheet at int. call
The default setting is 0. This parameter determines which tab should be selected in 
the event of a query from ACWin. Possible values are 0 to 3.

– Tabsheet at ext. call
The default setting is 0. This parameter determines which tab should be selected in 
the event of a query from ACWin. Possible values are 0 to 3.

– Company
Contains the field name of the subscriber table for the values returned to ACWin. The 
default setting is company.

– Sortname
Contains the field name of the subscriber table for the values returned to ACWin if "au-
tomatic name retrieval" is set in ACWin.
A31003-G6640-U100-2-7619, 03/2010
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Settings
● Key pressing

– Data source
When a key is pressed in ACWin, DSWin searches for this data source.

– Search field
When a key is pressed in ACWin, DSWin searches for this field in the data source.

– Search panel
When a key is pressed in ACWin, the characters are displayed in the search panel in 
DS View.

– Dial properties
If you click this button, the following dialog is displayed with fields from the subscriber 
table:

You can determine in this table which button dials which station number. Note the call param-
eters in the GUI Designer for ActionType = PHONECALL in this regard. The CallNumber pa-
rameter 0 to 9 corresponds in this case to the table row.

These values contain database field names, whereby it should be noted that input is case sen-
sitive.

– Use internal flag

– Data source:

– Internal code:

– Domain

– Tie number:

– Country code:

– Area code:

– Net code:

– Extension:

Confirm input in each dialogue window by clicking OK.
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Settings
2.2.4 BLF-Win Settings

Choose the BLF-Win tab under Application settings to access the BLF-Win settings.

● Active
This setting should only be enabled if BLF is installed on the same computer as DS-Win. 

● BLF window title
Part of BLF window title. Only the first pair of significant characters are important (case 
sensitive) for identifying the window.

● BLF-Win number field
Corresponds to the field name of the Station field in the subscriber table. Please use the 
default settings for reasons of backward compatibility.
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The Standard Screen
2.3 The Standard Screen

The window illustrated shows the configuration supplied with the software package. It may look 
different in your application if it has been adapted to the requirements of your company by the 
system administrator.

Please note that the size of the window should only be adjusted using the "GUI Designer" pro-
gram. If you enlarge or reduce the size of the window while DS View is running, it may happen 
that components are not enlarged or reduced automatically at the same time and therefore may 
not be visible.

You can select the DS-Win functions in the standard screen using icons and menus. The icons 
in the toolbar enable you to structure the data view on the screen. The menu items that appear 
when you click on them are self-explanatory.

If you drag the cursor onto the fields in the menu bar or toolbar, the relevant functions will be 
displayed. When you do this for the first time it may be necessary to click on them to make the 
functions visible.

Workspace

Status bar

Menu barToolbar Title bar

Search fields
 A31003-G6640-U100-2-7619, 03/2010
2-10 DS-Win V4, User’s Guide DS View

      



ds-winbh.c02.fm

For internal use only. Data View
The Standard Screen
The large screen area is your workspace which is terminated at the bottom by the status bar. 
The workspace can be configured individually and may therefore differ in appearance from one 
installation to another. The workspace is where you make your entries and results are dis-
played. Messages and information about completed program steps and the status in different 
modes are displayed in the status bar.

The system is controlled via the menu bar. 

When you click on the titles above, the following sub-menus are opened:

You can also call up some of these dialogs directly from the toolbar underneath:

From left to right:

File menu ● The File menu is required for opening DS-Win applications that 
can be used alternatively.

● If you click on Open, the DS-WIN applications contained in the 
current directory are displayed. Double click on the application 
you require.

View menu ● You can use the View menu to activate or deactivate the status 
bar and toolbar.

Options menu ● The Options menu provides you with additional functions: 
It enables you to select a search procedure and various print op-
tions, to configure the application and set the language. You can 
make changes to data records by clicking on Edit.

Help menu ● By clicking on Help, you can access the online help.

If you then

(1) Open a dialog file you look for your file and place it in the workspace.

(2) Select edit mode you switch modes (view or input mode).

(3) Activate a speed search you switch to a search using a character string.

(4) Activate a result search you switch to a search using defined terms.

(5) Set print mode to "List" you print the displayed data in list form (phone book).

(6) Set print mode to "Record" you print a single record.

1 2 3 4 65
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The Standard Screen
The buttons in the workspace make it easier for you to use important DS-Win functions. The 
layout of the buttons depends on your individual settings and may differ from the layout depict-
ed here.

If you click then

Subscriber
Secretary
...

you call the selected subscriber via their phone number. You can dial 
additional phone numbers using other configured buttons 
(for example secretary, mobile telephone).
Note: 
If additional phone numbers are configured, you can dial them using 
the key combinations Ctrl-1... Ctrl-9. Refer also here to the "Dial pa-
rameters" dialog, which you can access via the "AC-Win" tab with the 
"Dial parameters" button. The CallNumber parameters for the 
"Action Type=PHONECALL" button, which are defined in the GUI De-
signer, also take effect here.

Phone book/
Record

you print either all displayed records (phone book) or only the record 
that is marked at the moment.

Result you start a result search.

Clear you delete all entries in the search fields.
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2.4 Searching for Data

You can choose between two search methods: 

● Result search 

● Speed search

You can set the search mode via:

● Options

● the toolbar

● function keys (F5 for speed search, F6 for result search)

Click with the mouse to activate the search mode you want. This will then be active in the fol-
lowing search procedure.

2.4.1 Speed Search (F5) and Automatic Dialing

With the speed search, the characters in the search term are entered in successive order in 
only one field; the system immediately directs you to the record that best matches your entry.

The records are sorted according to the column in which you are searching. If you enter a 
search string in the search field of another column, data is sorted according to this column be-
fore the search task is initiated.

As soon as the correct entry is found, the connection can be set up by pressing the Station key 
(subscriber or secretary). You can reach alternative numbers via other buttons if configured, 
and using the key combinations "Ctrl-1 ...  Ctrl-9".

2.4.2 Result Search (F6)

Select this method to look for linked search criteria, e. g. according to name and department 
simultaneously. After entering the search criteria in the search fields, you can start the search 
process by clicking the "Search" button or by pressing F3.

F5 for speed search

F6 for result search
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The result you receive from this search will be the set of records corresponding to the criteria 
entered. 

You can search with or without a wildcard. With wildcards, you can either extend or restrict 
search criteria as required:

You should note that when using other databases, other wildcards may be required.

2.5 Pre-Selecting Areas

If your data is divided into various areas, you can use the combination box in the upper right 
margin to preselect records. To do this, open the list of available areas and mark the corre-
sponding entry. Only records from this area are now displayed.

2.6 Viewing Search Results

After completing a search, the result is displayed on the screen in edited form. You can change 
the display to show detailed data (see Section 2.6.1 on page 2-15) and you can also print out 
the results (see Section 2.6.4 on page 2-18).

If you use the 
wildcard

the system replaces

? any individual character.
Example: With "MA?OR" all values are searched which start with 
"Ma", end with "or" and also contain additional letters in the middle, 
for example "Major", "Mayor", "Manor", etc.

[..., ...] only characters between brackets.
Example: With MA[N,J,Y]OR, only "MAYOR", "MAJOR" and "MAN-
OR" are searched.

[...- ...] only characters between brackets.
Example: 0-9 means all characters.
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2.6.1 Displaying Detailed Data

You have the option of displaying detailed data both on the "Search for subscribers" tab and on 
the "Selected subscriber" tab.

2.6.1.1 »Search for subscribers« Tab 

You can display detailed data in the result table. If the first column for a record displays the  
icon, you can simply double-click on this icon to display additional data in sub-rows.

Slider

Arrow keys
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Show All

If you want to show all displayed records in this way, click on the "Show" button.

Hide Detailed Data

Hide All

If you want to hide the detailed data of all displayed records click on the "Hide" button.

Merging a Display

A display containing several records of the same type can often be very confusing, especially 
if the contents in the individual fields are similar. 

In order to structure a display of this kind click on the "Merge" button. The structured display is 
not shown. If you first displayed the detailed data, the detailed data is hidden automatically for 
the structured display. 

Cells that are horizontally and vertically adjacent and that contain the same information will be 
displayed by DS-Win as a single large cell, which increases clarity considerably. 

There are several ways of moving about the table

● by clicking the arrow keys to scroll up and down in the list 

● by dragging the slide tab to scroll to the upper or lower section 

● by using the cursor keys to access other data records in the table – the current data record 
is darkened.

The detailed data of an individual record is hidden.
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2.6.1.2 »Selected subscriber« Tab

You can use the "Selected subscriber" tab to switch to form display for the record currently 
marked. This display is also required for editing individual records.

There are several ways of switching the current data record. You can use the following buttons 
to do this:

● First for the first record in the table

● Previous for the previous record

● Next for the next record

● Last for the last record in the table
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2.6.2 Altering Sort Settings

You can easily modify sorting for your search result.

The value of the field on which sorting is based is imported to the search field. This simplifies 
searching in this column because the term which has already been found does not need to be 
entered again.

Examples:
A specific subscriber was searched for, however no connection was possible as the subscriber 
was unavailable. The caller asks to be connected with another subscriber in the same room. In 
this case, simply click on the column "Room" to immediately display all subscribers in the room 
where the originally requested call partner is located. You can now select a new subscriber.

Because a connection could not be set up with the first subscriber searched for, the caller asks 
you to connect him to the supervisor of the relevant department. If departmental names are 
classified hierarchically, the supervisor’s departmental name contains either one letter or one 
digit fewer. Click on the "Department" column and then press the backspace key to delete the 
last characters of the term contained in the search field. This branches you back to the higher 
hierarchy levels where the other station required can be found.

2.6.3 Deleting Search Criteria

If you have entered several search criteria for the result search, you do not need to delete each 
search field individually before a new search. Simply use the corresponding accelerator.

2.6.4 Printing Results

You have the option of printing

● a single record or

● the complete list of all records (phone book).

To do this, activate either Print List or Print Form in the toolbar.

Step Action

1 Click on the title of the column according to which sorting is to be performed.
Result: The table is resorted accordingly.

Step Action

1 Press the key combination Ctrl + Del.
Result: The contents of the search fields are deleted.
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Depending on the switch setting you have selected, either the Phone Book or Record button 
will be displayed clearly for selection. 

All available print forms are displayed in the "Options" menu under "Print form". You can click 
to select a print form.

In the print mode "List" the records are printed in the same order as displayed in the output ta-
ble. If you switch to the result search before printing, you can conveniently define record selec-
tion and sorting. Record selection is defined by specifying search criteria in the search panel. 
All fields completed in the search panel are used for sorting. The search field to the furthest left 
is the main sort criterion. All other completed search fields are included in sequence in the sort 
criterion. 

Example:
You would like to print a list sorted according to location, and within the location according to 
department, and then according to name.

Step Input Action

1 Switch to the result search.

2 Text Enter the required search criteria in the search fields "Location", 
"Department" and "Name". You can also only use the first charac-
ters of a search term.

3 Press the "Result" button on the right side of the main window.

4 Switch to the print mode "List" and select a print form.

5 Press the button "Phone Book" on the right side of the main win-
dow.
The records are now printed in the required order.
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2.7 Editing Records

The Data view window allows you to edit individual records directly, providing you have the ap-
propriate access authorization to the database. Switch to the Selected subscriber tab because 
it is only possible to edit data records in form fields and not in the list view.

You can switch from display mode to input mode as follows: 

● By choosing the Edit menu option in the Options menu or 

● By clicking the "Input mode" icon or

● Using the F2 key

● Other buttons appear on the right-hand side of the workspace.

● You have already selected a record. To edit the current record, you have to click in an ed-
itable field. The buttons on the right side are then activated. 

2.7.1 Editing Records with the Control Buttons

When you click the ... 
button

then

you save the changes in the current record.

you discard changes.

you remove the current record from the database.

you insert the new record in the database.

you create a new record.
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2.7.2 Editing Combination Boxes with the Keyboard

Text is not entered directly in combination boxes, rather it is selected from a list of possible val-
ues and then transferred to the field. These fields can be edited both with the mouse and the 
keyboard. If the cursor is located in a combination box (field content is selected), the following 
accelerators are available.

Requirement: The combination boxes were preconfigured in the GUI Designer.

2.8 Opening an Existing Database in DS View

When DS-Win is started, a database containing the last settings saved appears automatically. 
You can open a different database via the File > Open menu.

Using the key or key 
combination

you can

Alt + Down arrow display the possible values in a drop-down list.

UP, DOWN scroll line-by-line though the list.

PgUp, PgDn scroll page-by-page through the list.

Shift + Enter accept the selected value in the combination box.

Del delete the value in the combination box.
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3 eMail Client and Presence Management

3.1 eMail client

3.1.1 Features

DS-Win V4 supports the following eMail formats: 

SMTP Server
The eMails are transferred to an available SMTP server in the network. This server is respon-
sible for delivering the eMails to the addressees.

SMTP Relay
The eMails bypass the SMTP server and are sent directly to the address domain’s eMail server. 
To find this domain’s mail server, there must be a DNS in the LAN and it must be possible to 
reach the destination computer in the eMail address via this DNS.

MAPI
If an Outlook client is being operated on a DS-Win desktop, which supports the MAPI protocol, 
then both the interface of the Outlook client and the interface of the DS-Win eMail client can be 
used. The eMail address can be transferred automatically from the DS-Win database in this 
case also. 

Outlook OLE
An existing MS Outlook must be started (not Express) and is used via the OLE interface.

eMail messages are only sent in this mode - none are received. When using the SMTP modes, 
it is also technically impossible to receive eMails.

Automatic Transfer of eMail Address to the eMail Client.
A database field can be programmed freely so that the eMail address is automatically trans-
ferred to the DS-Win eMail client.

Standard texts for both the Subject Line and the Message
Standard texts for all languages released are supplied in the Message.doc file and can be cus-
tomized. 
This Message.doc file and samples of standard texts can be found after installation in the DS-
Win directory "ProgramData\Siemens\DS-Win V4\SendMail\". 

Three different standard texts can be accessed in the eMail client via buttons. The names of 
these buttons are freely programmable.

The message is displayed in RTF format (Rich Text Format) which supports the use of a range 
of fonts, styles and colors to make layout clearer.
The text can be edited directly in the eMail client. The range of RTF formatting options available 
here is limited (e.g. no Color selection). WordPad is available in the eMail client menu and offers 
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a better selection of RTF formatting options for editing messages. The actual text displayed in 
the eMail client is then automatically transferred to WordPad. The changes made are immedi-
ately displayed in the eMail client once you have saved and quit WordPad.

Adaptation of Customer-specific Dialogs for DS-Win Data View with the eMail Client
You can use the Designer to modify existing DS-Win data view custom dialogs for use with the 
eMail client. The section entitled Configuration of the eMail Client contains instructions on this.

3.2 Configuration of the eMail Client

3.2.1 Prerequisites

The DS-Win eMail client can be used by the attendant staff to send an eMail informing absent/
busy subscribers about a call. 

There is no need to reply to this eMail and consequently the system is not designed to receive 
eMails (to avoid involving another host (POP3)).

The client therefore only supports the SMTP protocol (not POP3) for sending eMails. 
The network therefore must feature an SMTP host or a DNS (Domain Name System) 
when using SMTP Relay. 

If you want to receive eMails, an eMail program that supports the MAPI protocol (e.g. MS Out-
look) must be installed on the DS-Win workstation.

The DS-Win eMail client can retrieve the eMail address of the subscriber to be notified from the 
database. This is supported for SMTP/MAPI/OLE. 
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3.2.2 Customizing Customer-Specific Dialogs / Configuring a Button 
for eMail

For default installation, the supplied configuration files "<INST DIR >da-
ta\forms\designer_de.xml" or "<DSWIN INSTALLDIR dir>\data\forms\designer_en.xml" al-
ready provide preset eMail configuration data.

The eMail function must be manually configured if customer-specific modifications have al-
ready been performed in DSWin. To do this, please refer to the instructions that describe how 
to program the button with the eMail function in DS-Win and how the database field can be dis-
played with the eMail address in DS-Win.

To enable the sending of an eMail, a button must be programmed with the Send Mail function 
and a name (in this case: Send Mail) assigned.

Precise configuration details can be found in the Designer manual in the Chapter "eMail Client 
Dialog Configuration".
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3.2.3 eMail Settings

Before you can send eMails, a number of modifications must be performed on opening the 
Email Settings tab in the Application settings dialog for the first time.

Open the Application settings menu from the options and select the Email Settings tab.

If a checkmark is set for Subject and Message under Defaults, then the current texts entered 
in these two fields in the eMail dialog are saved as standard Text1. Every time the Send Mail 
button is now pressed, these texts will be displayed under Subject or Message. 

7 The changeover to the MAPI/Outlook EMail User Interface is permanent but is con-
figured in DSWin_view_config.xml. See Section 3.2.3.5, “MAPI/Outlook Email User 
Interface”, on page 3-8.
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The following dialog will appear after selecting a subscriber and pressing the Send Mail button:

Please note that the caller’s telephone number cannot be inserted correctly if the wildcard for 
the telephone number (+XX (XXX) XXXX) was deleted. In this case, 1234 is added after "Caller 
Number:"!!!

Comment: The wildcard XX [XXX} XXXX itself can be defined by qualified personnel in the 
message files Message1.txt or Messag2.txt in the DS-Win directory "ProgramData\Sie-
mens\DSWin V4\SendMail":
For example change to. +XX[XXX] - XXXXXX:

The wildcard parameter can also be changed in the file "C:\ProgramData\Siemens\Ds-Win 
V4\config\DSWin_View_config.xml". Should you change it, please make sure that the value in 
the configuration file is identical to the value in the "Message.txt" file.

Comment: The telephone number is not inserted if this entry contains fewer than two charac-
ters. The number of the incoming call is available as soon as "Send Mail" is pressed and re-
places the wildcard.

The mail texts are saved in the files Message1-3.txt in the DS-Win directory 
C:\ProgramData\Siemens\DSWin V4\SendMAil. Three different standard texts can be se-
lected for the message with the buttons Text 1-3. The standard text displayed can be tempo-
rarily deleted by pressing Delete to send an eMail with a different text.
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3.2.3.1 eMail Type

The eMail transfer method can be defined with "Email type". 

3.2.3.2 Defaults

Specify whether the Subject line is to be used. 

To send an eMail, the sender’s eMail address must be entered in the Sender field (in this case 
the attendant console). This entry is used as the sender in the eMail so that the eMail recipient 
can see who sent the message. This entry must not be a real eMail address, but Microsoft nam-
ing conventions must be observed.

An eMail address can be entered in the BCC field (optional) to which a copy of every eMail is 
to be sent by default. This must not be used and is only provided here for information purposes 
showing who the eMail was sent to, when it was sent and what the contents were.
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3.2.3.3 SMTP Server

The name or the IP address of the SMTP host on the network is entered in the Hostname field 
(if necessary, consult your network/SMTP host administrator).

The default Port need not normally be modified. 

Whether or not the UserID has a significance depends on the configuration of the SMTP host. 
This field must not be left blank however. Although SMTP hosts frequently overlook this 
UserID, an entry must always be present. Please check with the SMTP host administrator to 
see if a random text (for example "default", "attendant") or a particular user login is necessary. 
The Passwort only has to be entered here if the SMTP server also expects a password for Use-
rID. The Timeout parameter specifies how long the system waits for a DNS response when 
sending a message before aborting the send attempt.
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3.2.3.4 SMTP Relay

SMTP Relay mode can also be used here if the SMTP host is not known or if there is no special 
SMTP server available. In this case, the DNS (Domain Name Server) is used to determine the 
receiving mail server for every eMail address, and the mail is sent directly to this server. (A task 
that is normally performed by an SMTP server.) For this to work, it must be possible to reach 
the destination computer specified in the eMail address via this DNS. The IP address of 
the DNS can be determined in the DOS box with the command IPCONFIG /ALL. Whether or 
not this mode works within the network depends on the configuration of the DNS and the eMail 
server. 

3.2.3.5 MAPI/Outlook Email User Interface

The MAPI setting facilitates the use of external eMail programs that support the MAPI interface 
(for example Outlook). In this mode, the current mail settings of the external software are ap-
plied (User name, Server etc.).

3.2.3.6 Outlook/OLE

This setting can only be used if an Outlook client is installed on the DS-Win PC. Outlook is then 
addressed directly via the OLE interface. This may be faster than via the MAPI interface. A 
choice of user interface is also available here (see under MAPI).
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3.3 Presence Management for DS-Win V4

3.3.1 Description of DS-Win Presence Management

This new function does not affect the traditional DS-Win attendant console functions or the in-
terworking with external HiPath applications (AC-Win, BLF). 

Presence Management for DS-Win can run with Microsoft Outlook 2003/2007, with Exchange 
Server 2003 as well as Lotus Domino R8 / Lotus Notes R8.

Figure 3-1 Overview of HiPath Applications

Public 
Network

AC-Win, DS-Win
and BLF-Win

or
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Figure 3-2 DS-Win V4 Configuration Overview

3.3.2 Configuration Requirements

Microsoft Outlook 2007 must be installed on the same PC as DS-Win. 

First activate presence management and set the requisite parameters (see Section 2.2.2, 
“Presence Settings”, on page 2-4).

3.3.2.1 Outlook

Since calendar data for MS Exchange Server (2003) is accessed with Outlook 2007, a mailbox 
for Outlook should be configured on the mail server (MS Exchange). If the Exchange server is 
integrated in a network and synchronization between the individual servers is configured, then 
data retrieval is possible throughout the net. 

MS Outlook Client 
2003 to 2007

Lotus Notes Client

MS Exchange Server 
Network

Lotus Notes Server

Update of sub-
scriber data

HiPath 4000 
Network
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3.3.3 Description of the »Presence« Window

Figure 3-3 The "Presence" window 

The "Presence" window can be positioned between the data grid and the search panel, for ex-
ample. However, this position can change at any time because, like other window elements, this 
window is created in runtime mode with the DS-Win Designer. 

The calendar entries show the presence of the selected user in chronological order (current 
record: red). As usual, records can be changed using the mouse, arrows or in the Search field, 
and the data retrieved after a short period of inactivity (see Section 2.2.2, “Presence Settings”: 
ChangeSelectionmSec) from Outlook or Lotus.
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These records are used as label text for the 12 fields in the "Presence" window and displayed 
in 3 rows and 4 columns. They can have the following values and meanings:

In Lotus Notes, only the "Busy" status is available.

The entries are the three most current entries of the selected user . They normally refer to the 
present or the future. However, one (or more) entries can in worst case be from the past as well, 
but only today, if there is no other suitable data for the present or the future.

The display of a past event from today can be important, for example, if a meeting doesn’t end 
on time.

In Outlook, it is possible to make overlapping calendar entries. In such cases, DS-Win shows 
only one entry; the following priorities apply:

● High: Out of office
● Average:Busy
● Low: Tentative

Identification is performed in Outlook or Lotus Notes; accents can be omitted. As in Outlook, it 
is only necessary to enter the key portion of a name.

The time is not shown if the status is "Out of office" and applies all day. Instead, only the start 
time and end time are shown ("All day" means that the start time corresponds to the Start-
WorkHour constant and the end time corresponds to the EndWorkHour constant. See Section 
2.2.2, “Presence Settings”). This process is known as "combining date elements".

For the current date, the date is not shown but rather the text constant "Today".

The text "All day" appears in the Time column if the relevant activity takes all day. The start time 
corresponds to the StartWorkHour constant, and end time corresponds to the EndWorkHour 
constant. See Section 2.2.2, “Presence Settings”).

Output is to an accuracy of 30 minutes. The entry 8:32-8:45 is shown for example as 8:30-9:00.

If the eMail address field is empty, the FirstName and LastName columns from the subscriber 
table for the selected record identify the eMail account. If the eMail address field is filled out, 
however, these entries will be sent instead of the name columns because this information is 
more unique.

This "Presence" window appears in the following distributed dialog files: German 
(designer_de.xml), English (designer_en.xml), French (designer_fr.xml), Italian 
(designer_it.xml), Dutch (designer_nl.xml), Danish (designer_da.xml), Hungarian 
(designer_hu.xml) and Czech (designer_cs.xml).

You can use the Designer to modify existing DS-Win data view custom dialogs for use with 
"Presence Management". 

Icon Date Time Status

No longer actual 3 May All Day Tentative

 Actual Today 8.30-9.00 Busy 

Not yet actual 3 May - 6 May Out of office
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For information about this, see the  "eMail Client Dialog Configuration" chapter in the Designer 
manual.

If you no longer need the "Presence" window and need the space for other purposes, proceed 
as follows:

1. Clear down the database connection.

2. Remove the components described above.

3.3.4 Extreme Situations

The following windows containing security information appear when installing security patches 
for Outlook: 

This warning is only issued if the security setting is not suppressed. Refer to Abschnitt 3.3.6 for 
information on how to suppress this setting.

The user should select the maximum time (10 minutes) to minimize disruptions to standard op-
eration. This warning can be deactivated for individual users or user groups in the Outlook serv-
er configuration. For further information please ask the specialist staff. Further information on 
this subject can be found in the Service Manual.

Special handling rules determine how to proceed in exceptional situations, for example if the 
Exchange Server is not available. In this case, the following message appears: 

Follow the instructions. If this does not solve the problem, please contact the specialist staff.
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3.3.5 Performance

It takes less than a second to retrieve account data from a local server. 

MAPI server data can only be refreshed by logging off and on again. This takes on average 2-
3 seconds every 2 minutes (default value for SessionRefreshMin). This process runs in the 
background of a separate thread. The period of inactivity (default value ChangeSelectionmSec 
500 ms.) is preset to prevent excessively quick selection. 

A delay time (approx. 5-10 minutes in Outlook 2007 or exit and logoff Outlook) is set for syn-
chronization between the Outlook Calendar update and the updated answer from the Ex-
change Server. The data is thus not immediately updated when the user creates a new calen-
dar appointment entry. Unfortunately, we have no control over this side effect. 

1. In Outlook, select Tools -> Options -> Calendar Options -> Free/Busy Options. 

2. Set the value for "Update free/busy information on the server every x minutes" to the min-
imum value of 1 minute.
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3.3.6 Creating Custom Security Settings

Security settings for Outlook users can be individually adapted in the Outlook Security Form. 
This form is available via Outlook Security Settings (Public Folders). Fill out this form and send 
it off. You can do this in two ways: you can create a custom security setting that applies to a 
specific user group or you can create a default security setting that applies to all users who are 
not included in a custom security setting. When you choose a custom security setting, you do 
not need to specify any users, you simply set the "Security Group Name" to "Default Security 
Settings.oft". You will find this file under "C:\Program Files\Siemens\DS-Win V4\Outlook\Out-
lookSec". Please refer to the file "ReadmeOutlookSecurity.txt" in the same directory to estab-
lish how and under which conditions this file can be opened.

Tab 1 in the Outlook Security Form: Outlook Security Settings
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Tab 2 in the Outlook Security Form: Programmatic Settings

Example: You can create a Power Users item that contains a list of members and the custom 
settings for this group. User names are stored in the Members box of the form and settings are 
stored in a variety of user-defined Outlook fields. Security features that you can configure in-
clude the following: attachment security, the Outlook Object Model Guard, the Simple MAPI 
guard, and the file extensions contained in the Level 1 or Level 2 lists for attachment security. 
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The following two windows show the minimum settings required to run DS-Win V4.
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